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1.1. Cintoo Solution Specifications
The Cintoo Solution
The Cintoo Solution is composed of Cintoo Cloud and Cintoo Connect.

• Cintoo Cloud is a cloud-based platform running on Amazon Web Services and Microsoft Azure with a
Web application to manage, view, share, enrich laser scan data in a collaborative way. Cintoo Cloud
can also be cloud-connected to BIM platforms such as Autodesk BIM 360 or BIM Track for Scan &
BIM workflows.

• Cintoo Connect is a Windows application running locally on users’ desktops or laptops, which is
cloud-connect to Cintoo Cloud exclusively. The purpose of Cintoo Connect is to:

◦ Prepare the scans (point cloud-to-mesh transformation) and upload them to Cintoo Cloud.
◦ Download the scans from Cintoo Cloud and export them in their source point cloud format.

IMPORTANT:

• Cintoo Connect cannot be run in standalone mode on desktops or laptops. It is run only from
Cintoo Cloud after the user has logged in to the platform.

• Not all users need to install Cintoo Connect.
◦ Cintoo Connect must be installed by users who will upload laser scans from their desktop

to Cintoo Cloud, or who will download scan data from Cintoo Cloud to get back point cloud on
their desktop.

◦ The users that will connect to Cintoo Cloud for viewing, measuring, annotating, cropping,
creating orthographic sections or elevations, etc. and who will not upload or download scan
data do not need to install Cintoo Connect.

Cintoo Cintoo Cloud User Guide - 1_en
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Specifications to Run Cintoo Cloud

• Software
◦ No plug-in required.
◦ Recommend WebGL browsers:

▪ Google Chrome
▪ Mozilla Firefox
▪ Microsoft Edge V79 or higher (which you can install from here).

◦ Microsoft Internet Explorer is not supported.
• Hardware

◦ Intel i5 or equivalent
◦ RAM of 4 GB or higher
◦ Any graphic board with at least 2GB of GPU memory

▪ 8 GB recommended for projects of several hundreds of scans.
• Network

◦ Recommended Internet connection bandwidth:
▪ Download: 10 Mbps (Megabits per second) or higher
▪ Upload: 1 Mbps or higher

Specifications to Run Cintoo Connect

• Software
◦ Windows 10

• Hardware
◦ Intel i5 or equivalent
◦ Recommended RAM depends on the size (=resolution) of your source scans:

▪ Default setting in Cintoo Connect is to process 2 scans in parallel.
▪ This number of scans can be reduced to 1 to reduce the RAM requirements below.
▪ Or increased to 8 if you have a more powerful PC with more RAM.

▪ RAM of 4 GB minimum is required to process 2 low-resolution scans (10 Million Points) in
parallel

▪ RAM of 8 GB minimum is required to process 2 scans of 40 Million Points each in parallel
▪ RAM of 16 GB is required to process 2 scans of 160 Million Points each in parallel
▪ RAM of 32 GB minimum is required to process 2 scans of 640 Million Points each in

parallel
◦ Graphic board: no specific requirements.

• Network
◦ Cintoo Connect will auto-detect the proxy.
◦ If the firewall still blocks the uploads and downloads via Cintoo Connect:

▪ Please ask your IT Department to white list the following domains: aec.cintoo.com and
cintoo.cloud both for uploads and downloads.

▪ Contact support@cintoo.com if the problem persists.

How to get Cintoo Connect?
Click on “My Projects” in the top bar and click on the project in which you want to upload data.

Cintoo Cintoo Cloud User Guide - 1_en
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• The new and latest version of Cintoo Connect is available directly from Cintoo Cloud web app by
click-ing on this icon here:

• Please download and install the latest version and follow the instructions to run the installation.
• Please note that you do not need to be an Administrator to install Cintoo Connect.

How to run Cintoo Connect?
Please refer to section Uploading Scan Data of this online documentation.

Cintoo Cintoo Cloud User Guide - 1_en

Page 6 of 230



1.2. Signing In
Logging in to Cintoo Cloud

Please make sure that you use Google Chrome or Mozilla Firefox as a Web browser when logging in.

After starting your free trial, login to https://aec.cintoo.com/login with your email address and password. You
are already set as an Account Manager.

You can then invite Project Manager(s) or set yourself as a Project Manager (see below).

• Project Managers can create projects, upload laser scan data in each one of these projects and use
the full features of Cintoo Cloud.

• They can also invite BIM / VDC Manager(s) and assign them to those projects. BIM / VDC Managers
can also upload laser scan data in each one of their assigned projects and use the full features of
Cintoo Cloud. BIM / VDC Managers cannot create projects

Cintoo Cintoo Cloud User Guide - 1_en
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1.3. Setting Project Managers
Inviting new Project Managers

You must be an Account Admin or co-Admin to invite Project Managers to Cintoo Cloud.

Project Managers can create projects, upload laser scan data in each one of these projects and use the full
features of Cintoo Cloud.

• Select Administration > Project Managers.
• Click on ‘Invite Project Manager’ at the top right.

• Invite your Project Managers:

• When one of these Project Managers creates a project, he/she can select the account and the plan in
the ‘Create Project’ window.

Cintoo Cintoo Cloud User Guide - 1_en
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Setting an Account Manager as a Project Manager

As an Account Manager, setting yourself as a Project Manager is easy:

• Click on Administration > Project Managers
• Toggle ‘on’ the ‘Add me as Project Manager’ at the top left.

• You now have access to the full features of Cintoo Cloud, including the capacity to create projects,
upload laser scan data, invite users and members, …

Making all projects visible to all Project Managers

You may decide to make all new projects visible to all Project Managers or not.

• If not, each Project Manager will only see his/her own projects in ‘My Projects’.
• To allow all new projects to be visible by all Project Managers:

◦ Click on Administration > Project Managers
◦ Toggle ‘on’ the ‘Add all Project Managers in new projects’.

Cintoo Cintoo Cloud User Guide - 1_en
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1.4. Users & Permissions
As a Project Manager, Admin or co-Admin

You can access Users & Permissions in the top bar of Cintoo Cloud. Users & Permissions then gives you
access to USERS, GROUPS, ROLES, PERMISSIONS.

• In ROLES, you can see all predefined roles & permissions and add custom roles.
• As a result:

◦ Those groups and custom roles created by any Project Manager, Admin or co-Admin now
become available at the account level for any project created in your account.

◦ All Project Managers, Admins or co-Admins can see and edit all the groups and custom roles
from all other Project Managers, Admins or co-Admins, thus facilitating the management and
the synchronization of this information.

If you are not a Project Manager, Admin or co-Admin
You cannot access Users & Permissions, so you cannot create any group of users and cannot create any
custom role.

If you have the permission to Manage Project Members (ex: BIM/VDC Manager role) you can add users to
a project by email invitation. The user(s) that you will add this way will be added to the Account Users list.

Cintoo Cintoo Cloud User Guide - 1_en
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1.5. Creating Groups of Users
In Users & Permissions, you have the capability to create your own directory of Groups of Users. You may
add or delete users from these groups at any time, which will directly impact those users’ access to the
projects to which they have been invited.

When clicking on GROUPS, this message appears:
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Clicking on in this window or on at the top right, you can then create your
own groups of users by entering a name and a description (optional):
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Once clicking on Create, you are then invited to add members to your group by picking in the Users
directory, or by providing a list of emails separated by a comma:
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Once users have been added, they appear in the directory for this specific group:

At this stage, you can still add users, delete users, duplicate the group or delete it. Each user can
individually be removed by clicking on the ‘Trash’ button at the right of the list:
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Now, you can select a project and invite Team Members for this project.

In the MEMBERS section within your project, click on . You are then offered the choice to
add individual members or groups of users.

Click on My Groups and select the group that you want.

The group then appears in your MEMBERS list as a single entity:

Click on to expand the group and see all the members in it. You can search for any individual.

IMPORTANT:

• If a user is added or deleted from a group, his/her access to this project will be updated accordingly
and automatically.

• If a user in one group has been invited to the same project individually or as part of another group,
his/her permissions on this project will be the cumulated permissions provided by these 2 invitations.
For example:

◦ Invited as part of a group, he/she can be assigned the role of a simple Viewer.
◦ Invited individually or as part of another group, he/she can be assigned the role of an Engineer.
◦ His/her role on this project will the cumulated permissions of the Viewer + Engineer.

You can delete this group from this project by clicking on . If some users of this deleted group
have been invited individually or as part of another group in the same project, they will remain active in this
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project with the permissions given by these other invitations.
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1.6. Usage Reports
As an Account Admin, you can generate usage reports and check who has been accessing the various
projects in your various subscriptions.

If you have several subscriptions (or plans), select one of them first.

Go to your ‘Administration’ tab and select ‘SUBSCRIPTIONS’. On the left, select the plan that you wish to
analyze.

Generate a usage report for the selected plan.

For the selected plan, click on ‘Generate Usage Report’ on the right.

Cintoo Cintoo Cloud User Guide - 1_en
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This will prompt a pop-up window, asking to select the period:

UTC means ‘Universal Time Coordinated’. Midnight UTC equals:

• 1:00 am UK
• 2:00 am France
• 9:30 am ACST (Australia Central Standard Time)
• 8:00 pm EST USA (previous day)
• 5:00 pm PST USA (previous day)

Clicking on ‘GENERATE USAGE REPORT’ will create a CSV file that will be downloaded from Cintoo
Cloud.

Using Excel, you can select all the columns and click on ‘Filter’ in the ‘Data’ tab:

Cintoo Cintoo Cloud User Guide - 1_en

Page 18 of 230



You can then sort your list per each column very easily:

Understanding the Usage Report.

• First name, last name, email company: Users who have accessed a project at least once during
that day.

◦ Note: Users who have accessed a project using a Shared View will be counted if they were
logged in to Cintoo Cloud while they accessed this Shared View.

• Scans downloaded: This column counts the number of scans selected in the Data tab when the user
clicks on the ‘Export Scans’ button (if the selection englobes work zones, all scans in the work zones
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will be included) and also the number of times the user clicks on the scan download button. It also
means that:

◦ Downloading the same scan multiple times will count as multiple scan downloads, not just once.
◦ Also, if the scan files are not successfully downloaded for whatever reason, it will still count in

the report:
▪ Problem with Cintoo Connect
▪ Download suspended because the user has closed Cintoo Connect
▪ Download not started since the user did not click on ‘Export’ in Cintoo Connect

• Crops downloaded: This column counts the number of times the user clicked on the ‘Export’ button
in the crop tool in either the Overview Map or the 3D View, whether the crop export was successful or
not.

• Unified mesh creation: This column counts the number of times the user clicked on ‘Create Mesh’,
whether this unification process was successful or not.

Cintoo Cintoo Cloud User Guide - 1_en
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1.7. Creating a New Project
Once you have accessed to Cintoo Cloud, invited a Project Manager or set yourself as a Project Manager,
you (or the invited Project Manager) can now create a first project.

Click on “My Projects” in the top bar:

In “My Projects”, click on “Create project”:

In the “Create project” pop-up window, fill in the various fields corresponding to your project.

In “My Projects”, select the project that you just created.

You can now invite team members (check our video: How to invite users?) or start uploading laser scan data
in this project. To start uploading data, you will need to install Cintoo Connect windows app first. See below

Cintoo Cintoo Cloud User Guide - 1_en
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1.8. Installing Cintoo Connect
Who needs to install Cintoo Connect?

Cintoo Connect must be installed on the Windows desktop of all the users who will upload laser scan
projects from their desktop to Cintoo Cloud, or who will download Reality Data from Cintoo Cloud to get
back point cloud on their desktop.

The users that will connect to Cintoo Cloud for viewing, measuring, annotating, cropping, creating
orthographic sections or elevations, etc. and who will not import / export Reality Data do not need to
install Cintoo Connect.

How to get Cintoo Connect?

Click on “My Projects” in the top bar and click on the project in which you want to upload data.

The new and latest version of Cintoo Connect is available directly from Cintoo Cloud web app by click-ing
on this icon here:

Please download and install the latest version and follow the instructions to run the installation.

• Open Server Manager
• Select Features | Add Feature
• Select Wireless LAN Service
• Install it and Restart the VM

Some third-party libraries we use require the installation of the Wireless Lan Service. By
default when configuring Windows Server 2019, this feature is not added. The solution is
to install this feature by doing the following inside the Windows Server 2019 VM:

!
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1.9. Uploading Terrestrial (Static) Scans
Terrestrial or Static Laser Scans

Terrestrial scans, also called static scans, are generated from a device mounted on a tripod.

Each individual scan comes with its depth map, associating X, Y, Z data to each pixel of the panoramic
image grid.

Structured scans need to be ‘registered’, i.e. aligned in a same coordinate systems, using a registration
software such as: Faro Scene, Trimble RealWorks, Leica Cyclone, Leica Register 360, Topcon ScanMaster,
Autodesk ReCap Pro… Once registered, the structured data contains each scan location, each panoramic
image & depth map, and the 3D point cloud, as the result from the registration process.

With structured scans, each scan location is visible in the 3D space. It’s possible to be in each scan
position, see the panoramic image and navigate from scan to scan.

Structured scan file formats supported by Cintoo Connect

• (Structured) RCP: the native format for Autodesk ReCap projects
• (Structured) FLS or LSPROJ: the native format for Faro Scene projects
• (Structured) E57: the standard exchange format for terrestrial laser scanning
• Every point cloud software provides the option to export a structured E57 file.
• To know how to generate a structured E57 from these software, please ask us at:

support@cintoo.com
• Note that there are other structured scan formats generated by point cloud software: FLS, PTX, TZF…

Cintoo Cintoo Cloud User Guide - 1_en
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Preparing your Cintoo Cloud project for the upload

You may want to:

• Either upload all your scans at once and then organize and assign them to various Work Zones
afterwards.

• Or create Work Zones first and upload your scans in each one of them if you know already the
organization of such data (for example: upload all level 1 scans in a Work Zone named ‘Level 1’, then
all level 2 scans in Work Zone ‘Level 2’, etc.).

You may also want to create a Work Zone to host all your scans (you may call it ‘All Scans’) before
eventually assigning them to sub-Work Zones.

Creating Work Zones

Select the project in which you want to create one or more Work Zones.

At the top right, select then ‘Create a Work Zone’ and fill the form (only the name is mandatory).

Uploading Scans

Click on “My Projects” in the top bar, click on the project in which you want to upload data, then select the
Work Zone in which you want to upload scans.

Click on “Upload Scans” from the top right of the window to start uploading scans:

Cintoo Cintoo Cloud User Guide - 1_en
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Or you can also click on “Prepare & Upload” from the middle of the window:

This will start Cintoo Connect on your computer:
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Select ‘Terrestrial Laser Scanner’ tab.

Select your RCP (Autodesk ReCap), FLS (Faro), LSPROJ (Faro Scene project) or E57 data. Please note
that either your RCP, FLS, LSPROJ or your E57 data must be a structured project (i.e. it must include the
location of each scan, the panoramic images, depth maps and the point cloud).

• Please check our video to understand the difference between a structured scan project and a unified
or unstructured scan project.

Once the RCP, FLS, LSPROJ or E57 file has been selected, click on ‘Import’. The process should start right
away (translation to Cintoo Reality Data first and upload next).

• Should there been some scans that have ‘lost’ their structure, you will get this type of display:

Cintoo Cintoo Cloud User Guide - 1_en
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◦ This case mostly corresponds to cases when, in a RCP Project Support file, not all scans have
their ‘RCC’ file. Cintoo Connect will still be able to upload those scans as ‘structured’.

• Should your selected scan file be a ‘unified’ point cloud, this warning message will be displayed:

◦ In this case, please refer to the team in charge of the laser scanning to request the source
‘structured’ file in RCP or E57 format.

• You can see each scan details by right-clicking on one of the scans:

◦ A pop-up window will then appear listing all the known information for this scan:

• If some of your scans have a resolution lower than 1,000 pixels in one axis, they will be automatically
unselected. They usually correspond to survey points, which do not need to be uploaded. Should you
want to include them still, please toggle them ‘on’ in the Cintoo Connect scan list.

• Structured scans that have lost their structure and that have less than 250,000 points are also
automatically unselected.

• On average, please allow around 1 to 2 min for the processing of one scan of 10 million pixels, 5 min
for 40 million pixels, and about 25 min for 160 million pixels (times may vary depending on your
computer).

• You may process more than 2 scans (default setting) in parallel if you have a multi-core machine (up
to 8 scans):
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• On average, you will need at least 400 MB of RAM per 10 million pixels to process. For example:
◦ 8 GB of RAM will allow you to process 5 scans of 40 million each in parallel.
◦ 64 GB of RAM will be needed to process 5 scans of 160 million pixels each in parallel.

• Change the scale factor only if you have been told to do so by the Surveyor.

◦ This scale factor expresses the difference between the local coordinate system that you need
for your scans and your models, and the geographical coordinate system (such as a State
Plane Coordinate System) used during the capture process.

• Regarding the ‘Remove deleted points from structured RCP’, please check this section of the
documentation.

• Regarding ‘Upload enabled’:
◦ It is checked by default, thus enabling the mesh-based scans to be uploaded automatically

once the point cloud-to-mesh transformation is completed.
◦ If ‘Upload enabled’ is unchecked, the point cloud-to-mesh transformation will happen locally on

your computer, but the resulting mesh-based scans will not be uploaded. You will need to
resume Cintoo Connect to upload your mesh-based scans later, for example when you have
access to high-speed Internet.

• Once a first scan has been uploaded, you can see the data in Cintoo Cloud by going to Data,
Overview Map or 3D View tabs. You may need to refresh the page to see the list of scans already
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uploaded.
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1.10. Uploading Indoor Mobile Lidar Scans
Indoor Mobile Lidar devices produce ‘unstructured’ point clouds by continuously scanning the space along
one or multiple walking path(s). While scanning, those devices also capture spherical images, which can be
fully spherical (360-degree horizontal) or partially spherical. The registration software sold with the device
will allow you to align one or multiple scanning sessions and to produce a single unstructured point cloud
using SLAM technology (SLAM = Simultaneous Localization And Mapping).

Uploading this resulting unstructured point cloud in Cintoo Cloud requires the installation and use of Cintoo
Connect 2.x or higher. Check this section to see how to install the latest Cintoo Connect version.

Cintoo Connect will then process this unstructured point clouds and ‘restructure’ them automatically.

• ‘Restructuring’ means that Cintoo Connect will create 3D scan positions as if your mobile data was
coming from tripod-mounted static scanners, thus facilitating the navigation experience.

• The resolution of those newly created 3D scans is computed automatically based on the resolution of
your source unstructured point cloud.

• There is no compromise on point cloud accuracy or density when using this process.
• Those newly created 3D scans will count as static scans in your scan capacity.
• You may download and export your newly created 3D scans from Cintoo Cloud as a unified or

structured point cloud as you would do with your static scan data.
• You may of course merge static scans and mobile scans in Cintoo Cloud and navigate between them

as long as they share the same coordinate system.

With Cintoo Connect 2.x, the following mobile devices or formats are supported:

• NavVis VLX and M6
• GeoSLAM Zeb series
• Viametris Backpack Mobile Scanner
• Gexcel Heron devices
• Leica BLK2GO
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• Emesent Hovermap
• Or generic unstructured E57 file with its corresponding camera path in CSV format

In terms of data types, Cintoo Connect 2.x supports the following unstructured formats:

• Point cloud file formats: E57 and PLY.
• Scanning path file formats: Generic CSV, GeoSLAM TXT, NavVis CSV and Viametris XYZ.

◦ With sub-sampling for the scanning scanning path positions.
• Optional scanning path geolocation: NavVis XML file.

For other devices or other types of unstructured data, please contact us at sales@cintoo.com.
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1.10.1. Uploading NavVis VLX or M6 data from
IVION
More about NavVis VLX or M6 devices here:https://www.navvis.com

The data that is expected by Cintoo Connect from the Mobile Indoor device, such as the NavVis M6 or the
NavVis VLX, is obtained from processed data folders that can be generated using NavVis IVION or using
NavVis desktop-based registration software. This section is about getting the data from the NavVis IVION
platform.

Getting VLX or M6 data from NavVis IVION:

You need to process your data in NavVis IVION using a parameter to embed panos in E57 (before
processing) as per Processing Data in NavVis Cloud | NavVis IVION Documentation

• In the Point Cloud Settings, set Point cloud resolution to 5 mm maximum (or less).

• In the Panorama settings, switch ‘on’ the “Include panoramas in .e57 point cloud” option.
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After processing your data in NavVis IVION, you will need to download an E57 file by following these
instructions: Downloading Data from NavVis IVION | NavVis IVION Documentation

Importing NavVis data using Cintoo Connect 2.2.x:

• Select ‘Upload Scans’ in your selected project and Work Zone.
• Select the ‘Indoor Mobile Scanner’ tab.
• Select ‘NavVis IVION’ as the Device / Format:

• You may modify the ‘Positions sampling’ value as needed:
◦ For example, ‘1/4’ will create 1 scan location for every 4 panoramic images included in the

scanning path.
◦ The number of 3D scans and average distance between each one will be indicated in Cintoo

Connect and will be added to your scan count.
• Click on ‘Import’.
• Check the ‘Messages’ tab from time to time to see if the process is running smoothly.
• Your new 3D scans will appear one by one in your Cintoo Cloud project.
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1.10.2. Uploading NavVis VLX or M6 data from
NavVis Desktop App
More about NavVis VLX or M6 devices here:https://www.navvis.com

The data that is expected by Cintoo Connect from the Mobile Indoor device, such as the NavVis M6 or the
NavVis VLX, is obtained from processed data folders that can be generated using NavVis IVION or using
NavVis desktop-based registration software. This section is about getting the data from the NavVis desktop
app.

The following data is needed to process the NavVis data:

1. The unstructured point cloud in PLY or E57 format
2. The walking /scanning path in CSV format
3. This CSV file is usually included in the same folder that contains the panoramic images.

• You may want to look for a folder call ‘pano’ or ‘panoramic images’ where the raw files for your
Indoor Mobile device are stored.

• Note: If this CSV file is not included in the same folder than the panoramic image, make sure
that it contains the path to the images in the right folder. For example, you can have the images
in a ‘pano’ folder, under the folder where the CSV file is. If all the image filenames are prefixed
with ‘pano/’ in the CSV file, the import workflow will work.

• Example content:

4. Optional: The geolocation information in XML format
• This geolocation information is usually produced while putting multiple scanning sessions in the
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same coordinate system.
• For single scanning sessions, this geolocation information is also produced when specifically

requesting the E57 file as an export from your registration software.
• This XML file may have an ‘_bundle’ in it for NavVis data.
• Opening this XML file, you should see all scanning sessions being listed with some position and

orientation for each.
• This data will be used by Cintoo Connect for the restructuring process followed by the point

cloud-to-mesh transformation and the upload to Cintoo Cloud.
• Example content:

Multiple sessions:

• If you have performed your scanning in multiple sessions, you will need to bring each point cloud (in
PLY or E57) one by one together with the scanning path for each (item 2 above).

• The geolocation XML (item 3 above) will also be mandatory in this case for each E57 import.
◦ Cintoo Connect will look for each point cloud file name in the XML file.

• Note that you can run several Cintoo Connect import sessions in parallel if your computer has enough
capacity.

Importing Navvis data using Cintoo Connect 2.2.x:

• Select ‘Upload Scans’ in your selected project and Work Zone.
• Select the ‘Indoor Mobile Scanner’ tab.
• Select ‘NavVis VLX and M6’ as the Device / Format:
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• Select the various files listed above in the various fields as shown in the example below:

• You may modify the ‘Positions sampling’ value as needed:
◦ For example, ‘1/4’ will create 1 scan location for every 4 panoramic images included in the

scanning path.
◦ The number of 3D scans and average distance between each one will be indicated in Cintoo
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Connect and will be added to your scan count.
• Click on ‘Import’.
• Check the ‘Messages’ tab from time to time to see if the process is running smoothly.
• Your new 3D scans will appear one by one in your Cintoo Cloud project.
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1.10.3. Uploading Leica BLK2GO Scan Data
More about Leica BLK2GO here: Leica BLK2GO – Mobile Mapping

The data that is expected by Cintoo Connect from Leica BLK2GO device is a single E57 file generated by
Leica Register 360 2022.0 or above, and Leica Publisher Pro.

• The Leica REGISTER 360 2022.0 supports the Command Line Interface (CLI).
• The Leica PUBLISHER PRO is required to run the CLI and add the trajectory in the E57.

Please refer to the section ‘Export BLK mobile data to E57’ on page 46 of this Leica documentation.

Importing Leica BLK2GO data using Cintoo Connect 2.x:

• Select ‘Upload Scans’ in your selected project and Work Zone.
• Select the ‘Indoor Mobile Scanner’ tab.
• Select ‘Leica BLK2GO’ as your source device / format:
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• Select the E57 file generated as described above.

• You may modify the ‘Positions sampling’ value as needed:
◦ For example, ‘1/4’ will create 1 scan location for every 4 panoramic images included in the
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scanning path.
◦ The number of 3D scans and average distance between each one will be indicated in Cintoo

Connect and will be added to your scan count.
• Click on ‘Import’.
• Check the ‘Messages’ tab from time to time to see if the process is running smoothly.
• Your new 3D scans will appear one by one in your Cintoo Cloud project.
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1.10.4. Uploading Emesent Hovermap Scan
Data
More about Emesent Hovermap here: Hovermap – Emesent

The data that is expected by Cintoo Connect from the Emesent Hovermap device and related software is a
E57 file together with the scanning path in .xyz format.

Importing Emesent Hovermap data using Cintoo Connect 2.x:

• Select ‘Upload Scans’ in your selected project and Work Zone.
• Select the ‘Indoor Mobile Scanner’ tab.
• Select ‘Emesent Hovermap’ as your source device / format:
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• Select the E57 file and the Scanning path (.xyz) generated by Emesent software.
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• You may modify the ‘Positions sampling’ value as needed:
◦ For example, ‘1/4’ will create 1 scan location for every 4 panoramic images included in the

scanning path.
◦ The number of 3D scans and average distance between each one will be indicated in Cintoo

Connect and will be added to your scan count.
• Click on ‘Import’.
• Check the ‘Messages’ tab from time to time to see if the process is running smoothly.
• Your new 3D scans will appear one by one in your Cintoo Cloud project.

Cintoo Cintoo Cloud User Guide - 1_en

Page 43 of 230



1.10.5. Uploading GeoSLAM data
Uploading GeoSLAM data

More about GeoSLAM devices here: https://geoslam.com

The data that is expected by Cintoo Connect from the GeoSLAM Mobile Indoor devices is the following:

1. The unstructured point cloud in E57 format
2. The walking /scanning path in TXT format

Importing GeoSLAM data using Cintoo Connect 2.x:

• Select ‘Upload Scans’ in your selected project and Work Zone.
• Select the ‘Indoor Mobile Scanner’ tab.
• Select ‘GeoSLAM Zeb series’:
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• Select the various files listed above in the various fields as shown in the example below:

• You may modify the ‘Positions sampling’ value as needed:
◦ For example, ‘1/500’ will create 1 scan location for every 500 frames included in the scanning

path.
◦ The number of 3D scans and average distance between each one will be indicated in Cintoo

Connect and will be added to your scan count.
• Click on ‘Import’.
• Check the ‘Messages’ tab from time to time to see if the process is running smoothly.
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• Your new 3D scans will appear one by one in your Cintoo Cloud project.
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1.10.6. Uploading Viametris data
More about Viametris devices here: https://viametris.com

The data that is expected by Cintoo Connect from the Viametris Mobile Indoor devices is the following:

1. The unstructured point cloud in E57 format
2. The walking /scanning path in XYZ format

Copying / pasting the XYZ file in the Images folder

Viametris software will export the scanning path in a file named ‘xxx_Camera.xyz’ in a folder called
‘SensorTrajectories’. You then have to manually copy this file and paste it in the corresponding images
folder, so that it’s located in the same folder than the corresponding panoramic images.

Importing Viametris data using Cintoo Connect 2.x:

• Select ‘Upload Scans’ in your selected project and Work Zone.
• Select the ‘Indoor Mobile Scanner’ tab.
• Select ‘Viametris Backpack Mobile Scanner’:
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• Select the various files listed above in the various fields as shown in the example below:

• You may modify the ‘Positions sampling’ value as needed:
◦ For example, ‘1/4’ will create 1 scan location for every 4 panoramic images included in the

scanning path.
◦ The number of 3D scans and average distance between each one will be indicated in Cintoo

Connect and will be added to your scan count.
• Click on ‘Import’.
• Check the ‘Messages’ tab from time to time to see if the process is running smoothly.
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• Your new 3D scans will appear one by one in your Cintoo Cloud project.
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1.10.7. Uploading Gexcel Heron data
More about HERON devices here: https://gexcel.it/en/

The data that is expected by Cintoo Connect from the Mobile Indoor device, such as Heron MS Twin Color
and HERON Lite Color is obtained from a dedicated process in Reconstructor software that generates a
structured RCP files in correspondence of each HERON photos.

In this specific case, clicking on ‘Export to Cintoo Cloud’ in Reconstructor software will automatically
generate the structured point cloud that is expected by Cintoo Connect. So there is no need to ‘restructure’
this data as for other mobile devices. Uploading data from Gexcel Heron devices will then follow the same
process than uploading terrestrial scans using RCP files. Please refer to the Uploading Scans sub-section of
this section of the online documentation to upload such RCP files to Cintoo Cloud.
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1.10.8. Uploading a generic E57 file with its
camera path in CSV format
The data that is expected by Cintoo Connect for unstructured scan data is the following:

1. The unstructured point cloud in E57 format
2. The walking /scanning path in CSV format

There might be 2 cases:

If the equipment has no camera (so no panoramic images has been produced):

• You must create a CSV file that contains the X, Y and Z location for each new 3D scan position that
you will want to create.

• Use comma (,) as column separator.
• Name the columns as x, y and z.
• x, y and z values must be in meters, in the same coordinate system as your scans.
• When processing the point cloud data, Cintoo Connect will create a 3D scan position at each one of

these XYZ location, together with a panoramic image made from the point cloud (with or without color
if the point cloud is colorized or not).

If the equipment has captured panoramic images:

Your 360° images must be stored in a single folder together with a CSV file containing the information about
the location and orientation of each panorama. The expected formats are the following:

• All the 360° images will need to be spherical images in Jpeg or PNG. Example spherical image:

• The same folder will need to include a CSV file that contains 360° image name (with extension),
location and orientation, for each 360° image.

• The CSV file will need to be as follows:
◦ Use comma (,) as column separator.
◦ The column for the file name must be named filename.
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◦ Filenames should have their extension (.jpg or .png).
◦ For the position, name the columns as x, y and z.
◦ x, y and z values must be in meters, in the same coordinate system as your scans.
◦ The orientation needs to be given as a quaternion or as a simple heading.
◦ Important: Since both quaternion notation and heading are supported as orientation, you

cannot have heading and quaternion in the same CSV. It is either one or the other, otherwise
Cintoo Connect will reject it.

• If you are using quaternions for the orientation:
◦ Name the columns as qx, qy, qz, qw.
◦ That way, your first column should look like (the order doesn’t matter): filename, x, y, z, qx, qy,

qz, qw
◦ It would be qw = 1 and qx = qy = qz = 0 for “no rotation” with quaternions.

• If you are using a heading value for the orientation:
◦ Create a column named ‘heading’ in the CSV file.
◦ The heading parameter represents an angle in degrees, a rotation around the Z axis. From the

top view, a positive angle represents a rotation in the clockwise direction (towards east).
◦ Important: when using heading there will be no rotation applied around the X or Y axes. We

assume that the 360° images are well aligned vertically (the plane crossing the “equator” line of
the must be parallel to the XY plane), otherwise the image will look as it is not straight (ex: a
straight building would look like it has some slope).

◦ The angle takes as reference the middle of the image and the north direction:

• Heading set to 0 means that you will see the middle of the image when looking towards north (+Y).
Heading set to 90 degrees means that you will see the middle of the image when looking towards east
(+X).

• Heading set to 180 degrees means that you will see the middle of the image when looking towards
south (-Y). Heading set to 270 degrees (or -90 degrees) means that you will see the middle of the
image when looking towards west (-X).

• Note that the Navigation Map on the bottom right corner can help you to find out to which direction
you are looking at.
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1.11. Importing ReCap projects with deleted
points
Instructions for deleting points in Autodesk ReCap

1. Deleted points in ReCap will still show up in your RCP file if you have used the ‘clip outside’ feature in
ReCap.

• So, do not use ‘Clip Outside/Clip Inside’, use ‘Delete’ during your cleaning process in ReCap.

2. After cleanup, when saving your RCP file, whether you use ‘Save’ or ‘Save as’, you will be prompted with
one of these messages below:
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• Do not use “optimize 3D point cloud only” or “remove 3D point cloud only”

Importing RCP projects that include deleted points using Cintoo Connect

• Install the latest version of Cintoo Connect by following the instructions here:

• Follow these instructions to upload scans to Cintoo Cloud via Cintoo Connect here

Special instructions related to RCP projects that include deleted points:

• When selecting your RCP file for import and upload via Cintoo Connect, this RCP file must be in read/
write mode since Cintoo Connect will attempt to modify it during the process.

• In Cintoo Connect, toggle the Do not import deleted points from RCP after selecting your RCP file:
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Note: The reading phase of the first scan of the RCP project will take some time (for
example, up to half an hour for a RCP project of 30 GB) because this is when the removal
of the deleted points of all scans occurs. The reading of the next scans will be as fast as
without the “Do not import deleted points from RCP” option.

*
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1.12. Support of Leica RTC 360 Scans
Cintoo Connect has been updated (version 1.8+) to support RTC 360 big images coming from Leica
Cyclone’s E57 export.

What has changed with Cintoo Connect 1.8+?

• Before Cintoo Connect 1.8+, scans captured with the Leica RTC 360 and exported via Cyclone in E57
format would show dark edges, no sky and low-resolution panoramic images when uploaded to Cintoo
Cloud.

• Coming with Cintoo Connect 1.8 (April 2nd, 2020) and further versions, scans captured with the Leica
RTC 360 and exported via Cyclone in E57 format would no more show dark edges, will show the sky
and high-resolution panoramic images (even if scanned with 160 million points per scan).

What about projects already uploaded to Cintoo Cloud with previous versions of Cintoo Connect
(before version 1.8+)?
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• Scans from RTC 360 that have already been uploaded to Cintoo Cloud with prior version of Cintoo
Connect (before 1.8+) will need to be re-processed and uploaded again with the new Cintoo Connect
1.8+.

• You do not need to export again your E57 file from Leica Cyclone.
• Your existing E57 should work with Cintoo Connect 1.8+.
• IMPORTANT: If you have used Cintoo Cloud’s alignment tool to move some scans, deleting and re-

importing them again with the new Cintoo Connect 1.8+ will restore the original positions (prior to the
use of the alignment tool).

Setting your image resolution when registering your RTC 360 scans with Leica Cyclone or Register
360
Be aware that you can set the image resolution when importing your source RTC 360 scans into Cyclone or
Register 360 prior to registration. This image selection cannot be changed then when exporting the
structured scans in E57 once the registration is completed..

• In Cyclone, check the ‘Cube Images Resolution’ at the bottom of this window:
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• In Register 360, check the ‘Pano Image Resolution’ in this window.
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• The 5120×5120 (aka 5k image) is the highest resolution, leading to the 200Mpx panoramic image that
Leica refer on their documentation (HDR resolution https://leica-geosystems.com/en-us/products/
laser-scanners/scanners/rtc360-image-resolution-white-paper).

• Note that 5k x 5k pixels is the resolution of each one of the 6 faces of the cube (cube map panoramic
type). The resolution of the equivalent spherical panoramic image is computed like so: width = 4 × 5k,
height = 2 × 5k, leading to a 20k x 10k resolution image (or more precisely 20480 × 10240 pixels).

• If you use the regular 2k (2048 × 2048) resolution for the cube image setting, it will lead to a 8k x 4k
pixels spherical image, which may be lower than the scan resolution (40Mp, or 10k x 4k grid for
example).

The image resolution of the E57 export from Cyclone or Register 360 is the same as the one set on the
import flow as there’s no option on the export menu to choose the resolution

Be sure to select the ‘cube map image’ export option when exporting to E57. See below.

Exporting E57 files from Leica Cyclone 2020 (or higher)

• Leica Cyclone 2020 offers an option to select the type of panoramic image when exporting E57 files.
• Please make sure to select ‘Cube Map’ to benefit from Cintoo Connect 1.8+ capabilities:

Installing the latest Cintoo Connect
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• Click on “My Projects” in the top bar and click on the project in which you want to upload data.
• The new and latest version of Cintoo Connect is available directly from Cintoo Cloud web app by

click-ing on this icon here:

• Please download and install the latest version and follow the instructions to run the installation.

Uploading scans

• Please follow the steps listed in section ‘Uploading Scan Data’.
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1.13. Point Cloud Cleanup using Leica
Cyclone Software
You can perform Point Cloud Cleanup within Leica Cyclone software and export that information out
as a structured .e57 point cloud to be uploaded into Cintoo Cloud via Cintoo Connect. (This content
provided by NOAR Technologies, a valued Cintoo Partner and Leica Registered Partner.)

• Open Registered ModelSpace

• Double Check that Scans aren’t Unified/Merged
◦ Click on point cloud to select cloud.
◦ If entire cloud lights up, and ‘one cloud’ is listed in bottom left, point cloud is unified and cannot

be cleaned for Cintoo.
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• Open the Layer Manager, and create Noise, Working, and Complete layers
◦ Shift + L opens manager
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• Select a single point cloud, and assign to Working layer

• Disable the visibility on Default, Noise, and Complete working layers
◦ This should leave one scan visible in the ModelSpace
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• Segment the cloud to remove noise
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• Select Noise and assign to Noise Layer

• Select all segments of the scan and run the Merge command
◦ Create Object -> Merge
◦ This will combine all parts back into one contiguous cloud
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• Select the point cloud and assign to the Completed layer
◦ This will turn the visibility of the cleaned cloud off

• Turn on the Default layer visibility and repeat steps 4-9 for each individual scan
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NOTE: Scan segments MUST be merged with their original scan before being placed on the
complete layer. Run this process one scan at a time, and Merge after the noise has been
removed. Orphaned scan segments will show up in Cintoo as unusable separate clouds
with small clips of data.

!
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1.14. Leica Cyclone-Export e57
This is a guide on how to export an e57 file from Leica Cyclone software (version 2021.1.0).

• In the Leica Cyclone – Navigator window, right-click on the registered ScanWorld to be exported, and
select Export

Select E57 Scan Format as the file type, and click Save:

In the Export ScanWorld dialogue, make sure all options are checked, and click Export:
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• If the import to Cintoo is missing 2D panoramic images, verify that the images being exported to e57
are cubemap images, not spherical images:

◦ In Cyclone, click Edit -> Preferences*… -> *Scan tab:

◦ Navigate to Export image to e57 as: and verify that Cubemap Image is selected:
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◦ Re-export the e57 file if needed.

EXAMPLE:

• Incorrect: 2D panoramic image missing in Cintoo:

• Correct: 2D panoramic image showing in Cintoo:
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1.15. How to Upload Scans from Trimble
Realworks
Step 1: You must first create a .tzf file

1. In Trimble RealWorks, go to Registration > Edit tab.
2. Then go to “Create tzf Scan”. If the project is not in the .rwp format, you will be asked to save it in this

format [2*].
3. Finally, in the Create TZF Scan window, you will need to select the creation mode: Please go for

Automatic as it should create the structured scan project at the best resolution as possible.
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Step 2: Export .tzf as a structured .e57
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1.16. Structured vs. Unified & Unstructured
Scan Data
Terrestrial or Static Laser Scanning

Each individual scan comes with its depth map, associating X, Y, Z data to each pixel of the panoramic
image grid.

Structured Scans

• The structured data contains each scan location, each panoramic image & depth map, and the 3D
point cloud, as the result from the registration process.

• Each scan location is visible in the 3D space.
• It’s possible to be in each scan position, see the panoramic image and navigate from scan to scan.
• File size for each scan is big.
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Scan view from one scan Position

Unified Scans

• Unified scans lose the ‘structure’ of the project.
• Scan positions are no more visible in the 3D view.
• Panoramic images are lost.
• Navigation from scan to scan is no more possible.
• The quality of the scan project is affected.
• Overall file size is slightly smaller, making the 3D point cloud somehow easier to consume in desktop

modeling apps such as Revit for example.

3D View—Scan Positions are no longer visible

Unstructured point clouds are generated from:

• Mobile Lidars
• Drone-based photogrammetry

◦ This data is ‘unstructured’ since there are no scan positions associated to a depth map as
produced with laser scanners on a tripod.

◦ It’s pretty similar to a ‘unified’ point cloud.
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Structured scan file formats

• (Structured) RCP: the native format for Autodesk ReCap projects
• (Structured) FLS: the native format for Faro Scene projects
• (Structured) E57: the standard exchange format for terrestrial laser scanning
• Every point cloud software provides the option to export a structured E57 file.

◦ Faro Scene, Trimble RealWorks, Leica Cyclone, Topcon ScanMaster…
◦ To know how to generate a structured E57 from these software, please ask us at:

support@cintoo.com
• There are other structured scan formats generated by point cloud software: FLS, PTX, TZF…

Structured-to-unified is possible.

• Every point cloud software provides the option to generate a unified point cloud.
• Turning a structured point cloud into a unified point cloud is a destructive operation though since the

structure of the scan data is lost and the overall quality is affected.
• Typically, 2 formats are used:

◦ Unified RCS, making your scan data directly consumable by all Autodesk desktop apps.
◦ Unified E57

Unified-to-structured is impossible.

• Once the scan data has been unified, all the ‘structure’ data of the project is lost, making it impossible
to recover it.
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1.17. Import & Display 360° Images (Beta)
You can import 360° images in Cintoo Cloud provided that those 360° images have been geolocated and
are in the same coordinate system that the 3d scans.

Beta feature
This is a beta feature starting Dec 14th, 2020. Being a beta feature:

• The access to it is valid for all Cintoo Cloud subscribers.
• The 360° images do not count as scans in your scan count.
• The maximum number of 360 images that you can upload to Cintoo Cloud is limted to the number of

scans that you subscribed to.
• For example, if you have a subscription for 5,000 scans, you can upload up to 5,000 additional 360°

images.
• 360° images are 2D only, so you cannot use them to add annotations (which are linked to a 3D point)

or to make measurements. They are used for display only.

Step 1 – Prepare your 360° Images

Your 360° images must be stored in a single folder together with a CSV file containing the information about
the location and orientation of each panorama. The expected formats are the following:

• All the 360° images will need to be spherical images in Jpeg or PNG. Example spherical image:

• The same folder will need to include a CSV file that contains 360° image name (with extension),
location and orientation, for each 360° image.

• The CSV file will need to be as follows:
◦ Use comma (,) as column separator
◦ The column for the file name must be named filename
◦ Filenames should have their extension (.jpg or .png)
◦ For the position, name the columns as x, y and z
◦ x, y and z values must be in meters, in the same coordinate system as your scans.
◦ The orientation needs to be given as a quaternion or as a simple heading
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▪ Important: Since both quaternion notation and heading are supported as orientation, you
cannot have heading and quaternion in the same csv. It is either one or the other,
otherwise Cintoo Connect will reject it.

◦ If you are using quaternions for the orientation:
▪ Name the columns as qx, qy, qz, qw
▪ That way, your first column should look like (the order doesn’t matter): filename, x, y, z,

qx, qy, qz, qw
▪ It would be qw = 1 and qx = qy = qz = 0 for “no rotation” with quaternions.

◦ If you are using a heading value for the orientation:
▪ Create a column named ‘heading’ in the csv file.
▪ The heading parameter represents an angle in degrees, a rotation around the Z axis.

From the top view, a positive angle represents a rotation in the clockwise direction
(towards east).

▪ Important: when using heading there will be no rotation applied around the X or Y axes.
We assume that the 360 images are well aligned vertically (the plane crossing the
“equator” line of the must be parallel to the XY plane), otherwise the image will look as it
is not straight (ex: a straight building would look like it has some slope).

▪ The angle takes as reference the middle of the image and the north direction:

▪ Heading set to 0 means that you will see the middle of the image when looking
towards north (+Y).

▪ Heading set to 90 degrees means that you will see the middle of the image when
looking towards east (+X).

▪ Heading set to 180 degrees means that you will see the middle of the image when
looking towards south (-Y).

▪ Heading set to 270 degrees (or -90 degrees) means that you will see the middle of
the image when looking towards west (-X).

▪ Note that the Navigation Map on the bottom right corner can help you to find out to which
direction you are looking at:

Step 2 – Upload the 360° Images using Cintoo Connect

You will need to use Cintoo Connect to upload 360° images.

• Install the latest version of Cintoo Connect (check this section: https://support.cintoo.com/manual/1/
en/topic/installing-cintoo-connect)

◦ This beta program starts with Cintoo Connect version 1.12.
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• We advise you to create a specific Work Zone.
• In this Work Zone, click on ‘Prepare & Upload’:

• Or click on ‘Upload 360° Images’ in the top right of the Window:

• This will run Cintoo Connect on your computer:

• The number of 360° images that you can upload is displayed:
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• When clicking on ‘Import’, you will need to select the CSV file that lists your spherical image:

• The import and upload process will start automatically.

360° Images Display

• Your 360° Images will be displayed in the DATA tab with a dedicated icon:

• In the the Overview Map, the 3D View and the Navigation Map, the 360° Images will appear with
green icons:
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• You can then navigate from a scan to a 360° image, a 360° image to a 360° image or a 360° image to
a scan.

• 360° images are 2D only, so you cannot use them to add annotations (that are linked to a 3D point) or
to make measurements. They are used for display only.

Cintoo Cintoo Cloud User Guide - 1_en

Page 81 of 230



1.18. Unlocking the BIM & CAD Module (BCM)
The BIM & CAD Module (BCM) can be unlocked by adding an option to the core CSD (Collaboration,
Sharing, Distribution) subscription. This unlock will be valid for all projects under the account that owns the
CSD subscription.

• Autodesk Construction Cloud and BIM 360 Interoperability
◦ Push RVT, NWD, NWC, 3D DWG, IFC from BIM 360 to Cintoo Cloud
◦ Select transformation to be applied to the Revit model (Shared Coordinates or Origin to Origin)
◦ All those 3D models will come with their hierarchy and metadata.

• Upload from the disk
◦ Upload IFC models from the disk.
◦ Those models do not include hierarchy and metadata yet (due for late Q4 2022).

• Align Scan & BIM
◦ Align Scan to BIM/CAD or BIM/CAD to Scan
◦ Export the alignment to Revit and Navisworks

• Compare Scan data & BIM/CAD Model (Scan vs. BIM/CAD)
◦ Overlay the BIM/CAD model to the scan
◦ Compare using the Visual Difference and Visual Check tools
◦ Generate heat map based on tolerance input

• Issue Tracking
◦ Export issues in BCF Format, PDF format or cloud connect to Autodesk BIM 360, Autodesk

Construction Cloud, BIM Track or Procore to push those issues in your issue tracking platform.

BCM Unlock

• When the BCM option has not been activated for your account:
◦ All projects will show ‘CSD’ below the thumbnail:

• Or in the project list:
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• When opening a project, the lock button at the top right will be greyed as well:

• When clicking on this button or when trying to access one of the BCM features, you will be
prompted a warning message recommending that you check with your Account Manager.

• Please refer to the pricing section of Cintoo’s web site to know more about the pricing of the BCM
option: https://cintoo.com/pricing/

• Once the BCM has been activated for this account, all projects under this account will display the
BCM status:

• When opening any project in this account, the lock button will be unlocked as well:
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2. Project Console
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2.1. Project Explorer
The Project Explorer is your Work Zone browser for each project. It will list all your Work Zones and sub-
Work Zones so that you can select them.

You can resize the Project Explorer from left to right if you happen to have long Work Zone names:

You may collapse or expand all Work Zones:
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You may close the Project Explorer to leave more space for the main window, or open it again:
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2.2. Resource Explorer
• Please select the Resource Explorer (formerly Work Zone tool) in the vertical tool bar of your 3D View

or your Overview Map:

• This will open the Resource Explorer on the right hand-side:

• The Resource Explorer allows you to browse, select, or unselect each one of your project resources:
Work Zones, scans, models, 360 images, Site Maps (Assets due for Q3 2022).

• The Resource Explorer also lists several possible ‘Actions’ related to your selected resource(s).
Those actions are similar to the available actions in the DATA tab for a selected Resource.

• For example, related to one scan:
◦ Here are the possible actions in the DATA tab:
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◦ Here are the actions available via the Resource Explorer for the same scan:

• When selecting multiple resources such as scans or models using Shift or Ctrl, you have the
possibility to create a new Work Zone and then move these selected resources in this Work Zone.
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• You can see the ‘Properties’ related to your selected resource(s) as well.
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2.3. Model Explorer
The Model Explorer will allow you to browse your model hierarchy and metadata if the BIM & CAD Module
(BCM) has been activated. See section “Unlocking the BIM & CAD Module” for details.

• Please select the Resource Explorer in the vertical tool bar of your 3D View or your Overview Map:

• This will open the Resource Explorer on the right hand-side.
• Select the model that you want to browse. Double click on it, or click on the 3 dots on the right to

show the various options.

• Clicking on ‘Explore Model’ will trigger the upload of the model hierarchy and metadata. This may take
some time, depending on the model size.

• The Model Explorer allows you to browse, select, or unselect each one of your model element.
• If the following message appears, the model that you are trying to browse was most probably

uploaded before the release of the BIM & CAD Module (before Oct 03, 2022).

◦ In this case, the only option is to upload the model again from Autodesk Construction
Cloud or BIM 360. Or to upload the latest version of the model (see section “Updating BIM
Models from BIM 360”)
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• The Model Explorer also lists several possible ‘Actions’ related to your selected resource(s). Those
actions are related to the selected file and are similar to the available actions in the DATA tab for a
selected Resource.

• ‘Properties’ lists the properties corresponding to the selected model or element.

• When selecting an element in the Model Explorer, you may:
◦ ‘Show’ it or ‘Hide’ it in your 3D View.
◦ ‘Isolate’ it from the rest of the model in your 3D View.
◦ ‘Go To’ it, which will zoom your viewpoint to the selected element.
◦ ‘Look At’ it, which will turn your viewpoint towards the selected element (no zoom).
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• You may also select any element of your 3D model in the 3D View by using the ‘Pick Models’ tool in
your top tool bar. This will have the same effect as the ‘Isolate’ feature in the Model Explorer.

• Picking a model element in the 3D View will automatically open the Model Explorer if it was not
already open, and will automatically highlight the selected element in the model hierarchy so that you
can easily get its Properties or isolate it for your analysis.

• Selected elements will appear in blue in the 3D View. You may unselect the element (and then
remove the blue highlight) with a CTRL + Click on the selected element in the Model Explorer.

• You can come back to the Resource Explorer to check all your other resources by clicking on the left
arrow at the top:
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2.4. 3D View
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2.4.1. TurboMesh
Cintoo Cloud’s 3D View is now fully powered by TurboMesh™, Cintoo’s mesh streaming engine at the
resolution of the scanner.

Since its first release in 2019, Cintoo Cloud has been leveraging a unique point cloud-to-mesh technology
that turns each scanning position into a multiresolution 3D mesh that can be streamed very fast in a web
browser. This technology preserves the accuracy of the source sensor and the structure of the project
(including panoramic images) while compressing the raw scan data by 10 to 20 times, making it much easier
to upload and store. Experts and non-experts can navigate their scans in a pure mesh-based experience,
viewing 3D surfaces that reveal details that they have never seen before, removing the ambiguity of point
cloud viewing.

With the new TurboMesh™ engine, our acclaimed mesh-based viewing experience is being extended to the
full 3D navigation in addition to the scan-to-scan navigation! With TurboMesh, anyone can navigate the
scans and experience the as-built data as 3D surfaces down to the resolution of the source scanner: no
compromise to accuracy!

• TurboMesh™ can be enabled / disabled in the top display bar in ‘3D Navi’ mode:

• Once enabled, if this is your preferred viewing experience, it will be saved as one of our user settings.
• TurboMesh™ is always enabled in ‘Scan Mode’, so there is no change in the viewing experience in

this case.
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Tip & Trick #1 when navigating in ‘3D Navi’ mode using TurboMesh™
You can experience your 3D Navigation using either one of the following 3D camera setups. Click on
‘Cameras’ in the vertical tool bar:

• ‘Ground’ will allow a smooth navigation with your 3D camera always parallel to the floor using your
left mouse button.

◦ Left mouse button: move parallel to the floor
◦ Right mouse button: pan in any direction, including up and down.
◦ Shift + Left mouse button: rotate around your current position
◦ Ctrl + Left or right mouse button: orbit around the clicked 3D point

• ‘Arc rotate’ provides a navigation experience similar to Autodesk ReCap.
◦ Left mouse button: orbit around the clicked 3D point
◦ Right mouse button: pan in any direction, including up and down
◦ Mouse wheel: Zoom in / out
◦ Shift + Left or right mouse button: rotate around your current position
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Tip & Trick #2 when navigating in ‘3D Navi’ mode using TurboMesh™
You may find useful to activate the ‘back face culling’ when navigating your scans in 3D Navi mode with
TurboMesh™ enabled.

• Back face culling will remove the mesh pieces, which normal is not oriented towards the camera.
• You can activate the backface culling in the Display Settings from your vertical tool bar:

• It is very useful to see the inside of a building from the outside. Example:
◦ Without back face culling:
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◦ With back face culling:

• When using TurboMesh™ in 3D Navi mode, it may remove unwanted mesh pieces coming from other
scans to get a cleaner scene. Example:

◦ Without back face culling:
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◦ With back face culling:
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2.4.2. Intensity
• Cintoo Cloud can display the intensity of the scans in the 3D View in either the Scan Mode or the 3D

Navigation mode.
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•

• The 3D Intensity display mode is available for the scans that have been uploaded with Cintoo
Connect version 1.7 or higher (from October 2019). If the 3D Intensity display mode is similar to your
3D Surface mode, that means that the intensity is not displayed for your scans and you will need to
re-upload those scans with the latest version of Cintoo Connect to benefit from this feature.

• 3D measurements and annotations can be added in 3D Intensity mode.

• The 3D Intensity display mode is also available in the Shared Viewer:

• The intensity data will be conveyed in the scans when exporting them from Cintoo Cloud.
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2.4.3. 3D Measurements
• 3D Measurements can be performed in Cintoo Cloud in the 3D View in either the Scan Mode or the

3D Navigation mode.
◦ Measurements cannot be made in the 2D Panoramic display mode. You must be in one of the

3D display modes.
◦ We recommend using the Scan Mode with the 3D Surface display mode to pick the right points

and make the most accurate measurements.

◦ Once the measurement has been created, it can be viewed in the 2D Panoramic mode as well.

• Click on the ‘Measurement’ tool in the vertical tool bar:

• Click on ‘+ ADD MEASUREMENT’
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• 3D measurement is then performed in the 3D View with information updated in real time:

• 3D Measurements include: Length, Height, Width, Angle (from horizontal plane), and measurement
along the X, Z and Z axis.

• 3D Measurements are saved with the context (camera position, display mode). For example, in 3D
RGB mode:
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• 3D Measurements can be exported in a PDF Report.
◦ Go to the REPORT tab of your project and select the ‘Activities’ that you want to be listed in the

report:
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◦ The PDF is generated when clicking on ‘Export as PDF’ and downloaded right away on your
computer.

◦ Each item title of your PDF report is clickable, allowing to display the corresponding activity in
Cintoo Cloud:
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2.4.4. Shared Viewer
You can share the 3D View with anybody or to selected users.

• Select the scan that will be used as the starting point for the Shared Viewer experience:
◦ In 3D View, switch to Scan Mode:

◦ Select the scan with its orientation and the display mode (2D Pano, 3D RGB, 3D Surface) that
you want to use as the starting scan, orientation and display mode.

• Click the icon shown below on the top bar of the 3D View:

• Select the options that you want.
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• You can customize the Shared Viewer by adding your own company logo.
• You then generate a unique URL that you can copy, turn into a QR code or send via a private email.

• Your recipients will need to use Google Chrome or Mozilla Firefox to view this 3D content.

• When sharing a scan from the DATA tab, the default view in the Shared Viewer will be the 2D
Panoramic mode:
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2.4.5. Navigation Map
A 3D Navigation Map is available in the 3D View both in Scan Mode and in 3D Navigation mode. You can
toggle it on/off by clicking on the corresponding button at the bottom right of the 3D View.

The Navigation Map is also available in the Shared Views.

The Navigation Map is created dynamically based on the RGB content of the scans. It is a top view of your
project, and it shows all the scan positions that are at the same level than your current viewpoint.

Inside the Navigation Map:

• The yellow cone depends on your current camera orientation and field-of-view. The transparency level
depends on the vertical orientation of the camera:

◦ Light yellow means that your current camera looks downwards.

◦ Dark yellow means that your current camera looks upwards.
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• You can pan or zoom in and out to select your next scan position.

• Hovering your mouse over one red icon will highlight the corresponding scan in the 3D View.

• You can click on any scan position to switch to this scan position in Scan Mode in the 3D View.
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2.5. Members
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2.5.1. Changing Team Member’s Role
You can change a Team Member’s role at any time by going to the “Members” tab in a given project.

• Select the person in your list of Team Members:

• Click on besides the role for the selected person.

• In the pop-up window, select the new role in the list and then save it.
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2.5.2. Assigning Groups of Users to a Project
After selecting your project, go to the MEMBERS tab:

When clicking on , you are given the following choices to add members either individually or
as a group:

You can then select one of your groups of users in My Groups and assign them all the same role.

Those Team Members will be notified by email and will then listed in the MEMBERS tab for this project.
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3. Project Toolbar
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3.1. Assigning Scans to Work Zones
There are 2 ways to easily assign scans to a Work Zone:

• Method 1: Either by manually draggring and dropping scans from the list in the DATA tab to the Work
Zone in the Project Explorer or in the DATA tab.

• Method 2: Or my selecting the scans in the Overview Map and creating a new Work Zone in the Work
Zone tab.

• Deleting a Work Zone is possible as well without deleting the assigned scans. See below.

Method 1 – Drag & drop in the DATA tab

• Create the Work Zone first using the button at the top right:

• Select your scans in the DATA tab (you can use Shift for a multiple selection):

• Then drag and drop them with your mouse to the right Work Zone either in the Project Explorer or in
the corresponding folder in the DATA list:
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Method 2 – Scan selection in the Overview Map

• Go to the Overview Map for your project.
• Select the orthoview (top, left, right, front or rear) and the display setting (RGB, X-Ray, Surface) that

will show the best view of your scan layout for a selection by the rectangle selection tool.

• Click on the ‘Rectangle Tool’ in the vertical tool bar:

• Use this tool to select the scans that need to be assigned to a given Work Zone.
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• By pressing CTRL and clicking on scan icons, you may remove some of the selected scans or add
non-selected ones.

• Click on the Work Zone tool in the vertical tool bar:

• In the Work Zone tab that pops up on the right, select the ‘Add Work Zone’ tool.
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• Give a name to your Work Zone:
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• Your selected scans are then automatically added to this Work Zone:

Deleting a Work Zone

• Deleting a Work Zone does not delete the data inside this folder (scans, BIM mode, documents…).
This data is then assigned to the parent folder.

• The Work Zones permission is necessary to delete those Work Zones. Anyone having this permission
can delete the Work Zones eventually created by other team members.
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3.2. Using Work Zones
Work Zones are used as a way to separate your data into separate folders for things such as phasing, date
captured, work areas, etc.

• In the Project Explorer on the left, select the project at the root or the Work Zone to be displayed in
the 3D View.

• This selected project or Work Zone must include all the data to be displayed, including the BIM model
eventu-ally.

• Click on the ‘Work zones’ tool.

• Use the ‘Work zones’ tool to toggle on/off the various data contained in your project or Work Zones, to
create Work Zones or to check some properties.
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3.3. Display Settings
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3.3.1. Switch On/Off Icons in 3D View
In the 3D View, you have the option to display or not the following icons:

• Click on in the top tool bar of the 3D View:

• Toggle On/Off the icons that you want displayed
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NEW:

• This selection will persist for each user independently.
• This selection will persist for ALL projects accessed by this user.
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3.4. Setting and Using a Site Map
Sites Maps are background images that will help locate and navigate the scans and the 360° images. Site
Maps may correspond to a 2D plan that has been scanned, a Google Earth, a Google Maps, a Bing Map or
an orthographic drone view of the site.

A Site can be at the root of the project or inside a Work Zone. You may have one Site Map per Work Zone.

Current import formats for Site Maps in Cintoo Cloud are JPEG and PNG. Resolution is limited to 4k * 4k
pixels.

Step 1 – Upload the Site Map image

• Select the Work Zone in which the Site Map will be uploaded.
• Select ‘Upload Documents’:

• Click on ‘Select Files’ to browse your PC to select the image, or drop the file as indicated below:
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Step 2 – Align the Site Map to the scans

• In the Overview Map, select the ‘Site Map’ tool:

• In the Site Map Settings, select the image first:
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• Once loaded in the view, you may use the ‘Visibility’ slider to double check that the selected image is
the right one.

• Click on ‘SELECT’ to select a first scan:
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• Click on ‘MATCH’ to match it to the Site Map:
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• When clicking on the picture, this will process a first match and the image will align to the selected
scan.

• Repeat the process for the scan 2.
• When clicking on ‘MATCH’ and then clicking the corresponding location in the image, this will adjust

the rotation and scale for the Site Map to adjust it to the scans.
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• You may fine tune your alignment by clicking on ‘MATCH’ and clicking again on the image to select
the scan location. This process can be run several times until you are satisfied with the alignment.
Using the ‘Visibility’ slider to adjust the relative transparency of the scan data and the image my help
in this process.

• Click on ‘SAVE SETTINGS’ before quitting the tool. The button turns green for a few seconds.
• Saving the Site Map settings will create an additional ‘Map’ file in the same Work Zone than the one

used to store the Site Map image:

Step 3 – Using the Site Map

• The aligned Site Map will be displayed in the Overview Map and in the Navigation Map of the 3D View
to help locate and navigate your scans.

• Scan icons and 360 image icons are displayed in red and green.
• In the 3D View:

◦ The Site Map is displayed in the Navigation Map at the bottom right of the 3D View to help
navigate your scans:
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• The Site Map is also displayed in the 3d View by default:

• You can toggle the display of the Site Map on/off by using the Work Zone tool and by clicking on

for the map :
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• You can use the crop tool in the Overview Map or in the 3D View, which will crop the scan data, 2D
drawing (if any) and 3D model (if any) but not the Site Map:
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Note:

• If your Site Map is a scanned drawing as in this example above with black lines over a white
background, the 3D View > X-Ray display mode will be difficult to use since this display mode
generates white lines as well:

• In this case, we recommend to either switch off the Site Map:
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• Or to use the Surface Mode (eventually with the ‘back face culling’ activated to see the inside of your
building) instead:
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3.5. Virtual Reality
Cintoo Cloud streams high-resolution 3D meshes from each scan position in a WebGL-compatible browser
and you can move from scan to scan by clicking on the scan locations displayed with an icon. VR Streaming
is all about the same workflow: high resolution 3D meshes are streamed in a WebGL browser that is WebVR
compatible, which will generate the 2 stereoscopic viewpoints that can been displayed via the VR app into
the VR display device.

Added Value of Cintoo’s Technology for Virtual Reality

• Highest possible resolution for the 3D mesh, coming from terrestrial laser scanners
• Fast streaming of the 3D mesh from each scanning positions
• Display modes: RGB, Surfaces, XRay
• Streaming of the mixed scan data + BIM content with possibility to display them separately or together
• Cloud-based or private-server-based solution for collaborative experiences

Recommended Configuration to run Cintoo’s VR Streaming feature

Supported VR Devices

• Oculus Rift or Rift S with 2 touch controllers
• HTC Vive, Vive Pro, Vive Pro 2 with 2 controllers
• Meta Quest 1 or Quest 2 with 2 touch controllers (must be tethered to a VR-ready PC with a

compatible USB-C cable)

Required Web browser

• Mozilla Firefox
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Required software

• Oculus desktop app (if using an Oculus/Meta device)
• SteamVR desktop app (if using an HTC/Vive device)

VR-ready laptop or desktop

• Equipped with a ‘good’ graphic board (such as NVIDIA GeForce GTX 1060 or better, or the equivalent
from AMD)

• HTC Vive provides detailed information about VR-Ready devices here: https://www.vive.com/us/
ready/#

• You can also test your PC in this page by clicking on ‘Test my PC’.

Please follow these instructions to make your Cintoo’s VR streaming work within Mozilla Firefox:

• If you are using a laptop with dual CPU (one NVidia graphics card and one Intel card), in the NVIDIA
Control Panel, set your web browser(s) to use the high-performance NVIDIA processor:

Please follow these instructions to make your Cintoo’s VR streaming work with Oculus devices:

• Install the Oculus app: https://support.oculus.com/1829158827315721/
• Once installed, in the Oculus desktop app, you need to authorize the ‘unknown sources’ in ‘Settings >

General’:
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Please follow these instructions to make your Cintoo’s VR streaming work with an HTC Vive device:

• If you use an HTC Vive Pro, see SteamVR support pages here: https://help.steampowered.com/en/
faqs/view/153F-1B04-6CAB-43A1

Running the VR Streaming experience:

• Launch Oculus Desktop or SteamVR, and make sure your VR device is connected and active
• Login to Cintoo Cloud using Mozilla Firefox.
• Select the project that you want to experience in VR.

• In the 3D View, click in the bottom right on: ===============>

• Click on the VR mask at the bottom right of the Window. =====>
• This will start the VR app and display the content in the VR headset.
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Cintoo VR – Troubleshooting
I. Windows Graphics Settings
In addition to setting the Firefox browser to use the high-performance NVIDIA processor within the NVIDIA
Control Panel, assigning the same setting in Windows Graphics Settings may resolve some issues that
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occur when using Cintoo’s VR feature:

1. Open Windows Graphics Settings:

2. Under “Choose an app to set preference”, select Desktop app from the menu and click Browse:
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3. Select Firefox from the list of apps and click Add:

4. Under Firefox, click Options, select High Performance, and click Save:
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5. Re-launch Firefox

ii. Enable VR in Firefox
Firefox browser versions 97.0.1 and newer may have some VR settings disabled by default. The following
instructions show how to make sure VR functionality is enabled in Firefox:

1. Launch Firefox and type “about:config” in the address search bar:
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2. Type “VR” in the search bar, and press ENTER
3. Toggle “dom.vr.enabled” to “true”:

4. Close and re-launch Firefox
5. Open your Cintoo project, navigate to the 3D View tab, and click the Virtual Reality button:
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6. Click “Allow” if prompted to allow Cintoo to access your VR device:

7. Click the “Switch to VR” icon to enter VR mode. In some instances, you may need to click the icon
more than once to push the scene to your headset:
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III. Disable Fullscreen in Firefox
In some cases, the Firefox Fullscreen API will interrupt Cintoo’s VR view from displaying in the VR headset.
Disabling Firefox from entering fullscreen mode can resolve this issue:

1. Launch Firefox and type “about:config” in the address search bar:

2. Type “full” in the search bar, and toggle “full-screen-api.enabled” to “false”:
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3. Close and re-launch Firefox
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4. Workflows
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4.1. Export Scan Data
There are two ways to export scan data out of Cintoo Cloud:

1. From the Data tab
2. From the Crop List (Learn more about the Crop Tool here)

Cintoo Connect must be installed on your local drive in order to export scan data.
(See instructions here)

1. Export scan data from the Data tab

• To export an individual scan, navigate to the desired file and click the Download icon:

• To export multiple scans at a time, select the desired files and click the Export Scans button:
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• To export an entire Work Zone containing scan data, navigate to the desired Work Zone and click the
Download icon:
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• To export multiple Work Zones at a time, select the desired Work Zones and click the Export Scans
button:

• Clicking the Download icon or Export Scans button will launch Cintoo Connect:
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• Scan data can be exported from the Data tab as a structured E57 or structured RCP file:

• Scan data can also be exported from the Data tab as an unstructured E57, RCP, RCS (Autodesk
ReCap format), or POD (Bentley Point Tools) file:
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• Click Export to initiate the mesh-to-point cloud conversion and export process:

2. Export scan data from the Crop List

• In the Overview Map or 3D View, click the Crop icon to open the Crop List:
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• Navigate to the desired crop region, and click the Export icon to launch Cintoo Connect:
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• Crop regions can only be exported as an unstructured E57, RCP, RCS (Autodesk ReCap format), or
POD (Bentley Point Tools) file:

• Click Export to initiate the mesh-to-point cloud conversion and export process:
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4.2. Export individual Scan URL
Each uploaded scan has been assigned a unique URL for the lifetime of the project in the cloud.

These scans can be individually shared from the DATA tab.

You can view all these URLs by exporting the scan parameters in an Excel sheet for the selected files.
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4.3. Embedding Cintoo Cloud Shared Viewer
in a web site using iframe
Embedding Cintoo Cloud Shared Viewer in a web site using iframe

• NOTE: Only Shared Viewer URLs are authorized in an iframe, any other URL will not work.
• Create a Shared Viewer URL for your project.

◦ See section: Shared Viewer
• Make sure that your Shared Viewer URL is accessible with no login/password.
• Copy the URL.

◦ Example: https://aec.cintoo.com/34183418143F343A3E3F
• Add an iframe on your site.

◦ Example code:
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4.4. Deleting Scans or Work Zones
The ‘Upload or Delete Reality Data’ permission allows any team member that has this permission (BIM /
VDC Manager, Surveyor) to delete scans.

The Work Zones permission also allows to delete those Work Zones, which means that anyone having this
permission can now delete the Work Zones eventually created by other team members.

• Deleting a Work Zone does not delete the data inside this folder (scans, BIM mode,
documents…). This data is then assigned to the parent folder.
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4.5. Register Cintoo with Autodesk
Construction Cloud (Require BCM Option)

• In the ACC Account Admin interface, click “Apps”:

• Under “Featured Apps” select “Cintoo Cloud” and click “Install”:
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• Click “Authorize and Install”:
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4.6. Register Cintoo with BIM 360 (Requires
BCM Option)
Cintoo Cloud is now available in the Autodesk App Store: https://apps.autodesk.com/en

Companies that have more than 100 users of BIM 360 are automatically enrolled in the APIs / Integrations
in BIM 360 and can directly follow these instructions below.

Companies with less than 100 users of BIM 360, please send an email to
bim360appsactivations@autodesk.com with your BIM 360 Account ID or an Account Admin’s email address
to enable the APIs / Integrations, then follow these instructions as well.

Go to your BIM 360 Account Admin.

Select ‘APPS’

Look for Cintoo Cloud app.

Click on ‘Add to BIM 360’.
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Click on ‘Authorize’.

You are done!
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4.7. BIM Track Integration
Make your laser scans part of your BIM Coordination!

• Create notes or issues in Cintoo Cloud by viewing or analyzing your laser scans, or by comparing
your scans to your BIM model.

• Push/sync those notes and issues to/with BIM Track for global tracking and BIM project coordination.
• Update, comment, assign these notes or issues as needed.

Step 1 – Connect your Cintoo Cloud Account to your BIM Track Hub

• Get your BIM Track token for the selected BIM Track Hub from your BIM Track Account Manager.

• Add this token to your Cintoo Cloud account.
◦ You must be either a Cintoo Account Administrator or Co-Administrator

• You may authorize access to several BIM Track Hubs (each one has a separate token).

Step 2 – Connect your Cintoo Cloud Projects to your BIM Track Projects

• Please note that that your BIM Track Project settings may only contain Priority, Status, Type in the

Please note that as of June 29th, 2020, BIM Track will stop showing your API key in the
Hub Settings Portal for improved security. From this date, if you need to access your hub
API key, you will have to revoke it and generate a new one, as explained in the BIM Track
REST API Help Center. In the eventuality you haven’t already stored your hub API key
somewhere safe and secure, we highly recommend you do so as soon as possible. Should
you have any questions regarding this security improvement, please do not hesitate to
reach out to your Support Team.

!

Cintoo Cintoo Cloud User Guide - 1_en

Page 162 of 230

https://help.bimtrack.co/en/support/solutions/articles/9000173873-bim-track-rest-api
https://help.bimtrack.co/en/support/solutions/articles/9000173873-bim-track-rest-api


“Issue mandatory attributes” under the project General Settings. Any additional mandatory attributes
could cause Cintoo Cloud to not sync with your BIM Track project.

◦ If you do require additional mandatory attributes, you must set a “default” value in BIM Track
in order for issue to push/sync.

▪ For example, if the Domain is a mandatory attribute for your project in BIM Track, be
aware that this attribute is not filled by Cintoo Cloud at this stage and will cause the sync/
push to fail. So, the workaround would be to set this Domain attribute (as per our
example) to be not mandatory in your BIM Track project or:

▪ Set a “default” value for Domain in your Bim Track project before push/syncing the
issue from Cintoo Cloud.

• Select your Cintoo project under My Projects that you would like to link to BIM Track and select the
REPORT tab

• Clicking on Link Project will link all your notes and issues with BIM Track.
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• Once you select the Link Project button the following dialogue box will open asking you to select your
BIM Track Hub and BIM Track Project

• Invite Users:
◦ Allows existing Cintoo Cloud users to be created as new users in BIM Track if they are not yet

BIM Track users.
◦ Applies to:

▪ Users that create the notes or issues
▪ Users that have been assigned an issue in Cintoo Cloud.
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• Push/Sync
◦ In ‘Push’ mode, notes and issues from Cintoo Cloud will be pushed a first time to BIM Track, but

all subsequent updates will come from BIM Track. In this mode, BIM Track acts as the ‘master’
for your notes and issues.

◦ In ‘Sync’ mode, updates may come from both BIM Track or Cintoo Cloud.
◦ This Push / Sync setting can be made for the whole Cintoo Cloud account, or for each Cintoo

Cloud project independently.

• Linking Notes & Issues
◦ In REPORT, clicking on ‘Link Selected’ will link all your notes and issues with BIM Track.
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▪ You may select the ‘activities’ for specific users only:

▪ You may select to push / sync issues only:
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4.8. Procore Integration
Make your laser scans part of your BIM Coordination!

• Create notes or issues in Cintoo Cloud by viewing or analyzing your laser scans, or by comparing
your scans to your BIM model.

• Push those notes or issues to Procore as ‘Observations’ for BIM coordination.

Preliminary Step – Turn ‘Observations’ tool ‘on’ in your selected Procore project

• Go to your Procore account. Select a project from top left menu and click on Project Tools to select a
tool.

• Click on Core Tools > Admin:

• In Admin, select Project settings > Active tools, from the right panel:

Note: “Private” notes that are created in Cintoo Cloud will not be pushed to Procore. They
are meant for private collaboration inside of the Cintoo Cloud platform only.*
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• Select Observations in the list and click on Update at the bottom of the page:

Step 1 – Connect your Cintoo Cloud project to your Procore project

• Go to the REPORT Tab and filter your issues via labels, users or activities, if needed.

Step 2 – Link your Cintoo Cloud project to your Procore project
• In the REPORT Tab, select ‘Integrations’:
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• In Integrations, select Procore > Link project…:

• If you have not logged into Procore from Cintoo Cloud already in the same session, you will be asked
to log in to your Procore account using your Procore login/password and authorize Cintoo Cloud to
access your companies and projects:
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• Clicking on Procore > Link project… will then prompt the following window, in which you can select
your company and project in Procore:

• Once the project has been selected, it appears at the top left of your REPORT Tab, and your notes
and issues are associated to a greyed Procore logo:
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Step 3 – Push your Cintoo Cloud notes or issues to Procore

• You can either push your own notes or issues, or those of your team members as well.
• Pushing notes and issues on behalf of one or more other Cintoo Cloud member(s) is only possible if

this(those) team member(s) has(have) already logged in to Procore from Cintoo Cloud and has(have)
authorized Cintoo Cloud to access his(their) hubs and projects.

• You can then push your notes and issues one by one or all at once.
• Pushing one by one is done by clicking on the greyed Procore icon associated with each issue. The

icon will then start blinking until it becomes stable and in color:

• Pushing all your notes and issues at once is done by clicking on Integrations > Procore > Push
Annotations to your project name:
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Step 4 – Getting your notes and issues in Procore

• You can access your pushed notes or issues in the ‘Observations’ tab of your Procore account.
• From Cintoo Cloud, you also can click on the Procore icon next to the note or issue to open this note

or issue in Procore.
• All the information included in your notes (title, owner, comments & attachments) and your issues

(title, owner, severity, due date, comments & attachments, assignee) are mapped to your notes and
issues in Procore.

• For issues, in order for the assignees to be mapped to your Procore Observations, they must have
logged in to Procore as well as they must have authorized Cintoo Cloud to access their companies
and projects, in the same session.

• If not, the assignees will not be mapped to your Procore Observations, but all other attributes will be.
• You can also link back your Observation from Procore to the same note or issue in Cintoo Cloud by

clicking on the hyperlink contained in the ‘Description’ field of your Procore Observation. You will then
see this note and issue in the context in which it was created in Cintoo Cloud.

Editing or deleting project links

• In Cintoo Cloud REPORT Tab, you have the option to edit or delete project links:

Cintoo Cintoo Cloud User Guide - 1_en

Page 172 of 230



• Editing a link will change the destination hub and project in your Procore account for new notes or
annotations to be pushed. Notes and annotations that have been pushed already will remain linked to
the previous hub and project in Procore.

• Deleting a link will delete the links to all notes and issues already pushed. They will then get a greyed
Procore icon, and they will need to be pushed again to a new project in Procore.
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4.9. Push Notes & Issues to Autodesk BIM 360
Make your laser scans part of your BIM Coordination!

• Create notes or issues in Cintoo Cloud by viewing or analyzing your laser scans, or by comparing
your scans to your BIM model.

• Push those notes or issues to Autodesk BIM 360 for BIM coordination.
• Private notes that are created also in Cintoo Cloud will not be pushed to BIM 360. They are meant for

private collaboration inside Cintoo Cloud platform only.

Step 1 – Connect your Cintoo Cloud project to your BIM 360 project

• Go to the REPORT Tab and filter your issues via labels, users or activities, if needed.

Step 2 – Link your Cintoo Cloud project to your BIM 360 project
• In the REPORT Tab, select ‘Integrations’:

• In Integrations, select Autodesk > Link project…:
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• If you have not logged in BIM 360 from Cintoo Cloud already in the same session, you will be asked
to login/password to your BIM 360 account and to authorize Cintoo Cloud to access your hubs and
projects:

• Clicking on Autodesk > Link project… will then prompt the following window, in which you can select
your hub and project in BIM 360:

• Once the project has been selected, it appears at the top right of your REPORT Tab, and your notes
and issues are associated to a greyed Autodesk logo:
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Step 3 – Push your Cintoo Cloud notes or issues to BIM 360

• You can either push your own notes or issues, or those of your team members as well.
◦ Pushing notes and issues on behalf of one or more other Cintoo Cloud member(s) is only

possible if this(those) team member(s) has(have) already logged in to BIM 360 from Cintoo
Cloud and has(have) authorized Cintoo Cloud to access his(their) hubs and projects, in the
same session.

• You can then push your notes and issues one by one or all at once.
◦ Pushing one by one is done by clicking on the greyed Autodesk icon associated with each

issue. The icon will then start blinking until it becomes stable and in color:

◦ Pushing all your notes and issues at once is done by clicking on Integrations > Autodesk > Link
Annotations to your project name:

Step 4 – Getting your notes and issues in BIM 360

• You can access your pushed notes or issues in the ‘ISSUES’ tab of your BIM 360 account.
• From Cintoo Cloud, you also can click on the Autodesk icon next to the note or issue to open this note
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or issue in BIM 360.
• All the information included in your notes (title, owner, comments & attachments) and your issues

(title, owner, severity, due date, comments & attachments, assignee) are mapped to your notes and
issues in BIM 360.

◦ For issues, in order for the assignees to be mapped to your BIM 360 issues, they must have
logged in to BIM 360 as well must have authorized Cintoo Cloud to access their hubs and
projects, in the same session.

◦ If not, the assignees will not be mapped to your BIM 360 issues, but all other attributes will be.
• You can also link back your note or issue from BIM 360 to the same note or issue in Cintoo Cloud by

clicking on the hyperlink contained in the ‘Description’ field of your BIM 360 note or issue. You will
then see this note and issue in the context in which it was created in Cintoo Cloud.

Editing or deleting project links

• In Cintoo Cloud REPORT Tab, you have the option to edit or delete project links:

• Editing a link will change the destination hub and project in your BIM 360 account for new notes or
annotations to be pushed. Notes and annotations that have been pushed already will remain linked to
the previous hub and project in BIM 360.
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• Deleting a link will delete the links to all notes and issues already pushed. They will then get a greyed
Autodesk icon, and they will need to be pushed again to a new project in BIM 360.
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4.10. Uploading BIM Models
In Cintoo Cloud, select the project in which you want to upload a BIM model.

Create a dedicated Work Zone to host this BIM model.

In this Work Zone, click on ‘Upload Models’.

A new dialogue box will now open:

By Selecting

Upload IFC models from your disk.
When exporting IFCs from Revit, go to Revit’s Advanced Settings:

• Make sure to use “Active Shared Coordinates”
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• Make sure to “Include IFCSITE elevation in the site local placement origin“.
• Make sure to select the right_ Level of Detail_ for the work that you need to do.

By Selecting

• Select ‘BIM 360’ as the source for your 3D data.
• Login to your BIM 360 account. Select your Hub and your project.
• Select your folder and model. Supported file types are: RVT, NWD, NWC, IFC and 3D DWG. 3D data

only.
• Some transformations are performed in BIM 360 using Forge APIs.
• When selecting a Revit file, you will be asked to select the positioning option between ‘Shared

Coordinates’ and ‘Origin to Origin’:

• You will be notified by email once the selected model is ready for viewing in Cintoo Cloud.
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4.11. Updating BIM Models from BIM 360
Starting October 25, 2021, you will have the ability to check for model updates in BIM 360 and to replace
the uploaded model with the latest and ‘Current’ version (as per Autodesk BIM 360 definition).

Note: This feature will work for new models uploaded from BIM 360 to Cintoo Cloud after October 25, 2021.
Models uploaded prior to this date will need to be uploaded again to benefit from this new feature.

Model Version
In the DATA tab for a given project, models uploaded from BIM 360 now have a version number attached to
it:

• In the list view:

• In the thumbnail view:
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Checking for updates

Click on ‘Check for updates’ for the selected model in the tile view or the thumbnail view.

If there is no update available, the following message will appear when clicking on ‘Check for updates’:

If there is a new version (set as ‘current’) for this model in BIM 360, you will get the following message:
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Clicking on ‘Update’ will prompt the following message:

After clicking on ‘Udpate’, you will receive a notification email after a few minutes (time for such notification
depends on the size of the model):
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Going back to your DATA tab in Cintoo Cloud, you will need to refresh your page to see the new version
listed.
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4.12. Alignment Tools (Requires BCM Option)
You may need to align your scans and the BIM model if they are not in the same coordinate system.

• In the 3D View, select the Manual Alignment Tool.

• Select the reference data and the one to be aligned. You may want to align the BIM model to the
scans or vice versa.

• During the alignment process, navigation in the scene can be in Scan mode (3D RGB or 3D Surface)
or in 3D Naviga-tion mode.

• Pick a pivot point on your data ‘to align’.
◦ In this example, the data ‘to align’ is the BIM model.

• Align this pivot point to the same point in your scan data by using the Translation tool.
◦ You may select a scan position and the Surface display mode to get more accurate

visualization.
◦ You can also play with the transparency levels for both the scans and the BIM model.

• For both the translation and the rotations, you can put your mouse in the text field, enter a value or
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use your mouse wheel to adjust.
◦ Using CTRL + Wheel, you will adjust by steps of +/- 10, with ALT + Wheel, steps of +/- 0.1,

SHIFT + Wheel, steps of +/- 0.01.

• Once the translation is done, adjust the rotation to align the model to your scans.
◦ You may select various scan positions to adjust this rotation.

• Once you are satisfied with the alignment, click on ‘Apply’ to save it.

• If you have aligned the scans to the BIM, this transformation will be applied when downloading and
exporting your scans as a point cloud (RCP, RCS, E57).
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4.13. Asset Management: Import, display and
export Asset Lists
Asset Management in Cintoo Cloud

An ‘asset’ in Cintoo Cloud references an object or equipment that has a unique ID, an XYZ location, and a
bounding box. It is part of a list. There can be several lists in a single project. An asset has specific
attributes such as labels, class of tags, description, hyperlink to a data base. It can be searched, cropped,
and exported in 3D as a point cloud or a 3D mesh. It can be seen from 1 or more scans. Lists of assets can
be exported from Cintoo Cloud together with the scan view corresponding to each asset of the list.

Assets in Cintoo Cloud can be populated from 3 sources:

• Importing lists of assets from CAD software, document management or Digital Twin platforms.
• Manually tagging assets using the 3D crop tool (second quarter 2022)
• Automatically detecting assets in the scans using Cintoo’s Artificial Intelligence (AI) engine (second

half 2022).

Assets can be viewed in their as-built context using Cintoo Cloud’s 3D View.
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Lists of Assets

Lists of assets can be imported in Cintoo Cloud by providing a CSV file that contains the following columns:

• Priority Fields:
◦ The column headers and content listed below will be used in priority even if they are not in the

order shown here:

◦ X, Y and Z are in meters in the same coordinate systems than the scans.
▪ It is supposed to be the center of the bounding box for each asset.

◦ Unit & Functional System
▪ Names cannot be different (*)
▪ These 2 columns may be left empty (*).
▪ Example:

◦ ‘Size’ corresponds to length of one side of the cubic box surrounding the XYZ location, in
meters (*).

▪ This approximates the asset bounding box.
▪ If left empty, default size will be set to 0.5 meters (approx. 1.5 foot).

◦ ‘Description’ is a text field.
▪ This column may be left empty.

◦ ‘URL’ means the hyperlink to the data base, the Digital Twin platform, the documentation of
each asset…

▪ Each URL must be a valid web link.
▪ This column may be left empty.

• Custom Fields:
◦ Up to 10 more custom fields and columns can be added to the CSV or Excel file, that contains

any type of alphanumeric characters.
◦ If there are more than 10 custom columns, only the first 10 will be taken into account, in

addition to the priority columns listed above.
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Importing Lists of Assets

To import a list of assets in a selected project:

• We do recommend that you create a dedicated Work Zone to host all your asset lists. Or you may
want to create sub-Work Zones below this main one to host each asset list.

• In the selected Work Zone, click on ‘Upload assets’:

• Or you may click on ‘Detect or Import Assets’ from your top right upload options:

• You will then be prompted the following pop-up window:
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• ‘Select ‘CSV – Import asset list’.

• ‘Color’ will help you navigate your list of assets in Cintoo Cloud’s 3D View (see below).

• If you have added Custom Columns, toggle on the ‘Capture additional columns as custom asset fields’
option:

• Select your CSV or Excel file.

• Once imported, your asset lists will be displayed in the DATA tab:
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• You can delete your list of assets from the DATA tab:

Viewing Lists of Assets

Once uploaded, your asset lists can be accessed from your 3D VIEW:

• Select the Work Zone of reference.
◦ You may want to select the ‘ASSETS’ Work Zone first if you don’t know in which area your

assets are located, or from which scans you can view those assets. When selecting a specific
asset, Cintoo Cloud will automatically open the Work Zone containing the best scan to view this
selected asset.

• In the 3D VIEW, click on ‘Assets’ at the bottom of the vertical tool bar:

• Your asset lists are then displayed on the right-hand side:
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• Note that the color on the left side is the color that you selected when importing each list of assets
(see above).

• You may delete each imported list individually:

• If scans are already displayed in the viewer, clicking on a list will show all the assets tags and the
bounding boxes in green.

◦ You may use the X-Ray display mode to see all the bounding boxes in the 3D view together
with the assets listed on the right-hand side:
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• If scans are not yet displayed in the viewer, clicking on a selected asset will automatically open the
Work Zone containing the best scan to view this asset.

• You can browse your list of assets by:
◦ Either clicking on the assets in the list,
◦ Or clicking on the bounding boxes in the 3D View.

Changing the Default View

• When uploading a list of assets, Cintoo Cloud computes which scans can see each asset, and
automatically assigns the closest scan to view each scan in Scan Mode (the ‘Asset View’).

• When an asset can be seen from multiple scans, Cintoo Cloud offers the possibility to select the scan
you want from these multiple scans (that can be in multiple Work Zones).

◦ Scans are listed with the Work Zone to which they belong.
◦ Example:

Cintoo Cintoo Cloud User Guide - 1_en

Page 193 of 230



• Clicking on one other scan will bring you to this other view.
• Or you may select to change to any other scan or change for a view in ‘3D Navi’ mode.
• You may also zoom in or out.
• Once you have changed the viewpoint, click on ‘Set as Default View’:

• Using the ‘Look At’ tool may help to visually locate an asset:

Searching for Assets

• You can search for assets using the Search Tool at the top of the asset lists:
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• The search will look for any information contained in the metadata (ID, Class, Unit,…).

• You can add multiple search elements by listing them in the search tool, separated by a space. The
search is then a ‘AND’ on all the selected elements. For example:

◦ Searching for all assets containing ‘ELT’:

◦ Searching for all elements containing ‘ELT’ and ‘45’:
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Linking Assets via Hyperlinks

• If hyperlinks were added as part of your lists, you can click on such hyperlink for each asset to access
to its content:

• Clicking in this hyperlink will open a separate window in your browser with this URL.

Displaying the Asset Metadata

• The metadata associated to each asset can be viewed by clicking on ‘Show Details’:

• Clicking on ‘Show Details’ will open a pop-up window showing the metadata, including the content
listed in the custom fields of your CSV or Excel file:
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Sharing Assets

• Each individual asset has its own hyperlink (‘Asset View’) that can be shared by clicking on the
‘Share’ button:

• Clicking on ‘Share’ will open this window, from which you can copy the hyperlink or generate a QR
Code:
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Exporting Lists of Assets

Lists of assets can be exported from Cintoo Cloud together with the Asset View corresponding to each asset
of the list, so that you can populate your Digital Twin platform with the as-built information coming from your
laser scans.

• From your asset lists, select the one you want to export:

• Clicking on ‘Export’ will generate a CSV file that corresponds to the one you uploaded, to which a new
column has been added containing the hyperlink (Asset View) for each asset.

• Note that you can also export lists of assets from the DATA tab:
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Editing an Asset List

You can edit a list of assets by uploading a new version of it. This new version of your list will append the
current one with the new content (added assets or modified assets).

• Select an asset list and click on ‘Edit’:

• You can also click on ‘Edit’ from the DATA tab:

• Clicking on Edit will open the upload window, where you can select the file to upload:
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Assets Display in Shared Views

• Refer to this section to create Shared Views: https://support.cintoo.com/manual/1/en/topic/shared-
viewer

• Assets can also be added to the list of items to be displayed in your Shared Views:

Cintoo Cintoo Cloud User Guide - 1_en

Page 200 of 230



Cintoo Cintoo Cloud User Guide - 1_en

Page 201 of 230



4.14. Comparison Tools (Requires BCM
Option)

• In the ACC Account Admin interface, click “Apps”:

• Under “Featured Apps” select “Cintoo Cloud” and click “Install”:
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• Click “Authorize and Install”:
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4.14.1. Scan vs. BIM

Using the Comparison Tool
• In the Project Explorer on the left, select the project at the root or the Work Zone that contains the

data sets that you want to compare. Your selections in the Comparison Tool will be limited to the
Work Zone and sub-Work Zones selected in the Project Explorer.

• Click on the ‘Comparison tools’.
• In ‘Selection’, select:
• The set of scans (or ‘All Scans’) that you want ‘To Compare’ to a reference.
• And the set of scans or the BIM model (or ‘All Moels) that will be used as ‘Reference’.

Using the Comparison Tool – Visual Difference Tool
• With the Visual Diff too, a heat map will be generated that highlights the difference between your data

sets (either Scan / BIM, BIM / Scan or Scan / Scan).
• The default view is bi-color.

• You can select either the metric or the imperial system.
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• You can then adjust the tolerance by using the slider or by typing a value.

• You can change to display setting to a gradient one by selecting ‘soft’.

• The Visual Diff Tool will colorize either the mesh or the BIM model/ scan data based on which
information is in front, superimposed, or behind the other one, in the viewer’s line of sight. In this
example of scan vs. BIM, the scan data is colorized.

◦ Everything red is in front of the BIM model at the distance higher than the one given in the
‘distance adjustment’.

◦ Everything green means that the scan data and the BIM model are within the range of the
‘distance adjustment’.

◦ Everything blue is behind the BIM model at a distance higher than the ‘distance adjustment’
value.
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Using the Comparison Tool – Visual Check Tool
• With the Visual Check tool, you have the flexibity to select the display mode for your scans between

3D RGB and 3D Surface.

• With the Visual Check tool, you use the transparency slider to compare your data sets.
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4.14.2. Scan vs. Scan

Scan to Scan Comparison Workflow using Visual Check Tool
• Select the Work Zones that contain the 2 sets of scans that you want to compare.

• The scans selected in “To Compare” will be highlighted in pink . These are the ones that will be
displayed in full resolution mode when navigating from scan to scan.

• The scans selected for “Reference” will be highlighted in white.

• Select a color for each group of scans in the Visual Check Tool.
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Example:
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4.14.3. Documenting Issues
• The user that has been assigned an issue (for example, a BIM Modeler that needs to add pieces of

BIM models from the scan data) can connect to Cintoo Cloud to crop the corresponding pieces of
missing data.

• He/she can then save those crops and export them as RCS files that will be geolocated at their exact
positions in the Autodesk modeling app, to facilitate their modeling job.
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5. Web Services
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5.1. Creating Unified Mesh
Step 1:

• Select the region of interest using Cintoo Cloud’s crop tool in the Overview Map or in the 3D View.

• The Overview Map has a rotation tool that allows you to get the X, Y and Z cropping axis along any
region of interest.

• Select your project or Work Zone.

• Rotate your scans to make sure that they are orthogonal to the screen axis.

• Use the X, Y or Z crops and any of the 6 axis views to select your meshing region.
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• The Overview Map rotation tool will not change the scans coordinate system. It is used to facilitate
the cropping but this rotation is not persistent.

• In the 3D View, your crop must be done in 3D Navigation mode, not in Scan Mode.
◦ In 3D Navigation mode, all the scans visible in the crop will be selected for the meshing.
◦ In Scan Mode, only the selected scan will be used for meshing.

• Save your crop.

Step 2:

• Click on ‘Create Mesh’ for the selected crop to open the ‘Create a Mesh’ window.

• Select the resolution (or density) from 0.2 cm (1/10 inch) to 20 cm (7.9 inches).
◦ This is the minimum distance between two vertices.
◦ Be careful when selecting the resolution (see Unified Mesh Use Cases & Examples).

• Select the export format: OBJ, FBX, STL
◦ OBJ: Photo-textures included
◦ FBX: Photo-textures included, lighter than OBJ
◦ STL: Geometry only

Be careful: huge meshes (large region with very small resolution) will take more time to
process and will hardly be displayed in any desktop app. See Unified Mesh Use Cases &
Examples section.

!
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Step 3:

• After some time, you will receive an email to inform you that your mesh is ready for download:
◦ You can then download directly using the first URL.
◦ Or go your project in Cintoo Cloud to download it as well. Save your crop.

Step 4:

• To download the unified mesh from Cintoo Cloud, go to your project or Work Zone and select ‘DATA’.
• Click on the download icon at the right of each unified mesh to download it.

• Or select the file and click on ‘Download Files’ at the bottom of the page:
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5.2. Unified Mesh Use Cases & Examples
Unified Meshes can be used for several purposes in desktop apps, once downloaded from Cintoo Cloud.
The following table categorizes some of these use cases, but there can be many other use cases not listed.

Examples of Unified Meshes created with Cintoo
Cloud
Category: Floors, Walls, Ceilings…

Oakland Train Station Interior

• Number of scans: 5 scans
• Type of scanner: Z+F
• Resolution of the scans: 40 million points
• Selected Unified Mesh resolution: 5 cm (2 inches)
• Selected Unified Mesh format: OBJ
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• Size of the Unified Mesh: 102 MB
• Number of faces in the Unified Mesh: 1,103,000
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Category: Floors, Walls, Ceilings…

Oakland Train Station Track Underground Level

• Number of scans: 22 scans
• Type of scanner: Faro
• Resolution of the scans: 40 million points

• Version 1:
◦ Selected Unified Mesh resolution: 5 cm (2 inches)
◦ Selected Unified Mesh format: OBJ
◦ Size of the Unified Mesh: 206 MB
◦ Number of faces in the Unified Mesh: 1,830,000
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• Version 2:
◦ Selected Unified Mesh resolution: 2.5 cm (1 inch)
◦ Selected Unified Mesh format: OBJ
◦ Size of the Unified Mesh: 487 MB
◦ Number of faces in the Unified Mesh: 5,620,000
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Category: Equipment, Machinery, MEP, Trusses…

Conveyor Belt

• Number of scans: 22 scans
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• Type of scanner: Leica BLK360
• Resolution of the scans: 12 million points
• Selected Unified Mesh resolution: 5 mm (0.2 inches)
• Selected Unified Mesh format: OBJ
• Size of the Unified Mesh: 788 MB
• Number of faces in the Unified Mesh: 9,222,000
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Category: Equipment, Machinery, MEP, Trusses…

Tech Shop Equipment

• Number of scans: 16 scans
• Type of scanner: Faros Focus3D 120
• Resolution of the scans: 7 million points

• Version 1:
◦ Selected Unified Mesh resolution: 2 cm (0.8 inches)
◦ Selected Unified Mesh format: OBJ
◦ Size of the Unified Mesh: 0.4 MB
◦ Number of faces in the Unified Mesh: 3,915
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• Version 2:
◦ Selected Unified Mesh resolution: 1 cm (0.4 inches)
◦ Selected Unified Mesh format: OBJ
◦ Size of the Unified Mesh: 1 MB
◦ Number of faces in the Unified Mesh: 12,106
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• Version 3:
◦ Selected Unified Mesh resolution: 0.5 cm (0.2 inches)
◦ Selected Unified Mesh format: OBJ
◦ Size of the Unified Mesh: 2.2 MB
◦ Number of faces in the Unified Mesh: 33,289
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5.3. Unified Meshes in Navisworks and Revit
Importing Cintoo Cloud’s Unified Meshes in Autodesk Navisworks and Revit is possible, although you have
to be careful about the size of the mesh that is being generated.

• Low mesh resolution (1 to 2 inches / 2.5 to 5 cm) will be preferred for building interiors, walls, ceilings,
floors…

• Medium mesh resolution (1/2 inch to 1 inch / 1 cm to 2.5 cm) will be preferred for point cloud sections
and slices, building structure (beams) or indoor equipment.

The proposed workflow is the following:

• Generate a Unified Mesh in Cintoo Cloud, selecting FBX as a file format.
• Import this FBX file in Navisworks.

◦ Colors are kept.
• Export a NWC or NWD from Navisworks, that will reference this mesh.

◦ This will have the effect of reducing the size of the mesh.
• Import this NWC or NWD file in Revit.

◦ Colors will be lost when displaying the mesh in Revit.

Detailed workflow

• Download your Unified Mesh in FBX format from Cintoo Cloud.

• Make sure that the FBX file and the texture maps and materials are all in the same folder (default
setting from Cintoo Cloud).

• Import this FBX file in Navisworks using the ‘Append’ tool:
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• The Unified Mesh is then displayed in Navisworks with its colors:

• Publish from Navisworks using .nwc or .nwd as a file format:
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• Import the NWC or NWD model in Revit using Coordination Model > Add:
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• The Unified Mesh will be displayed in Revit without the source colors:
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